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Welcome to File-Mate 1500 
File-Mate 1500 is a tool to organize and print your data for the Health Insurance Claim Form 1500 that 
health care providers must submit for payment of services.  File-Mate 1500 is organized as a data-
base.  As you enter data, the program automatically saves and arranges the data to fit the 1500 
form.  Easily move within a specific patients’ 1500 form(s) by using our quick tabs.   Editing is easy, 
just click the tab where the information you need to change is located and update your data. 
 
Installation 

You must use the installation program to install File-Mate 1500 - You can't install File-Mate 
1500  by dragging files to your hard disk. 
 
 
To install File-Mate 1500 on your hard disk: 
 
1)  Insert the CD into your CD or DVD drive, or  

 Click on the link in the email or receipt you received upon purchase of the software 

 Or  use the link to install the DEMO from our website:  www.formmagic.com 
 
2)  When you see the File-Mate 1500 Welcome panel, click NEXT to continue.  Agree and accept 
 the Licensing agreement. Click Next to continue.  
 
3)  In the Destination Location panel, choose the folder where you want to install File-Mate 1500. 
 
 By default, File-Mate 1500 will be installed in the C:\ File-Mate\FM4 
 or in the Applications folder on a Mac. 
 
 If you want to install File-Mate 1500 in another folder or on another drive, click the drop down 
 menu within the folder display and navigate to the folder where you want to install File-Mate. If 
 the selected disk doesn't have enough space for the files you select, or is write-protected, you  can 
 leave the installer and delete existing files to make more room on the disk. If the disk is 
 locked, or isn't a hard disk, you can choose another drive. 
 
 Click NEXT. 
 
4)  In the Select Start Menu Folder window, select the name that you would to have display in your 
 Windows Start menu. Default is File-Mate 1500. Click Next to continue. 
 
5)  In the Select Additional Tasks window, you can choose to have a desktop icon and/or a quick 
 launch icon created. Click Next to continue.   We suggest you have an icon placed on the desktop. 
 
6)  The Summary window is a summary of your previous choices, examine the contents, if they are 
 correct, click Install to begin the installation. 
 
7)  When the installation is complete, click Finish. 
 
8)  The program will now launch. 
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Home Page Tabs 
 
Patient Tab:  Clicking on the Patient tab will show each Patient entered into the system. Click 
the Patient you wish to view and any associated forms will be listed in the Forms list in the    
bottom half of the screen.  
 
Click on the form you wish to open to edit or click the NEW button to create a new blank form 
for the patient. 
 
If this is a new visit and you need to create a New Form, then click on the NEW button at the 
top of the screen.  You will then be brought to the form to enter patient data. 
 
See Creating a New Form (page 8) for details for entering New Patients.  
 
Insured, Providers and Carrier Tabs:   While in the Home Tab, you can see a listing of 
all Insured, Providers or Carriers in your system, by clicking on the appropriate tab.   Once on 
the correct tab, click on the name of the Insured, Provider or Carrier to see all forms related to 
that entity. 

THE HOME  TAB  Overview 
The Home page is the starting point for finding patient data or creating a new 1500 form. 
You can return to this view while anyplace in the program by clicking on the Home Tab.   
 
You can access entered data by clicking the titles at the top of the list.  

Home Tab 

Details  Tab 

You can quickly 
access a patient 
through the Find 
Patient search  
feature.  Enter a 
few letters of their 
first or last name 
and click FIND. 

Need to see all 
your patients? 

 
Click on the  

REFRESH LIST 
button.  
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Two views are available 
on the Home Tab.   
A standard view and an  
expanded view.   
 
Click on this button to 
EXPAND the List view.    
 
Click on this button to 
RETURN to the standard 
list view.    
 
 
The EXPANDED list 
view offers more Patient 
and Form data on each 
line for quick reference.  

STANDARD VIEW 

EXPANDED VIEW 
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 THE DETAIL TAB Overview 
This view will give you the contents of your patients’ record.  You can access this view by        
selecting a patient and clicking on the DETAILS tab or by clicking on the patient name on any 
form listed on the bottom of the screen on the home page.  
 
The tabs in this view correspond to the different areas of information on the actual 1500 form. 
 
You can easily move around the 1500 form by clicking the tabs (Patient, Insured, Provider,       
Service, Form)  at the top of the entry screen.   

The Patient 
tab is the in-
formation for 
boxes 1, 2, 3, 
5, 6, 8, 9, 10 
of the actual     
1500 form.   

Details  Tab 

The Insured tab is the 
information for items 
1, 4, 7, 9 and 11 of 
the actual  1500 
form.   
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The Provider tab is 
the information for 
items 25, 27, 32 
and 33 on the  
actual form.   

The Service tab is 
the information for 
items 14, 15, 16, 
17, 18, 20, 21, 22, 
23, and 24 on the 
actual form.  

If you have ques-
tions about the data 
and how to fill out this 
HCFA 1500 form per  
requirements, visit: 

 
www.nucc.org 
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The FORM tab shows you a replica of the actual 1500 form.  All the 
data you entered will show up here. You can use this as an  
accuracy check before printing.   

Use the Prev and Next buttons to scroll 
through multiple forms for this patient.  
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 Creating a 1500 Form 
 Creating a New Form 

 There are three options to create a new 1500 Form: 
• From the HOME page click the NEW button  
• From the drop-down menus select Forms then New Form 
• Hold down the CTRL key and type  N (CTRL+N). 

 

Entering Your Data 

Entering a new patient is easy in File-Mate 1500.   Use one of the methods listed above to open a 
new record.  The Patient tab will now be opened and a new, blank patient record will be displayed.  
 
Simply enter the patient information.  Use the tab key to move from field to field.   Use the drop 
down menus, where available to quickly fill in data.  At the bottom of each section there is a 
NEXT button to click to take you to the next part of the form.   File-Mate 1500’s simple,  wizard 
style of entry makes completing forms easy and fast! 

 
Note:  File-Mate 1500 auto-captures key data that you enter and places it in an “Index”.   
This index is available to you to use to quickly enter data.  You will see a CHOOSE 
INDEX button for applicable sections such as Patients Names, Insured Information, 

 Carrier and Billing information. 

Quick Entry 
Tip! 

 
When you have a         
returning  patient  

you can quickly  
DUPLICATE a 

previous form for 
the new service.  

Click on the PLUS  
symbols and a new 

form will           
automatically be 
created.  You can 
open the form to 

make any changes 
needed for this visit.   
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Tips for Entering Data: 
INSURED TAB—MULITPLE INSURANCE PLANS:  
 
 In the Insured section there are two tabs;  Plan Information and Other Plan 

Information.  If you click the YES button for Other Plan, you will be auto-
matically prompted to fill in that information when the NEXT button is 
clicked.  After completing the Other Plan Information clicking the NEXT  
button will take you to the Provider data page. 

 
SERVICES TAB —  DATES / PROCEDURES, CHARGES,  
  SUPPLEMENTAL SECTIONS: 
 
  The Services data page has a number 3 tabs within this section:   
   DATES / PROCEDURES, CHARGES,  SUPPLEMENTAL.  
  

• Fill in dates related to the patients’ illness.   
• Then number the illnesses or injuries related to your patient and begin 

filling in your service Dates and Procedures.   
• Click the NEXT button to move to the CHARGES tab and continue en-

tering the information. 
• Click the NEXT button  to take you to the SUPPLEMENTAL tab and the 

last information about your clients’ services.   
• At the bottom of  the Supplemental tab you can see the Print button to 

print the form or click on the Form tab to review the form before printing.  
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The Patient Tab -  Tips 

• This  Description field will show up as a description of the reason for the visit when you are on the 
Home Screen. 

 
Info Section:  This section relates to a specific FORM. 
• Open  - active form for a patient. 
• Archived - You can use this status to take the FORM off of the active list.  You can consider using 

this status for completed service, non-active patients or any reason you determine to call a form 
“archived”.  This form will still be accessible to view by changing status to archived.  

• Status:  Use the drop down menu to select the appropriate status of the form  
♦  New:    for new forms. 
♦ Updated:    if changes have been made. 
♦ Submitted:   to insurance. 
♦ Completed:   claim has been paid. 
♦ Edit:     Allows you to edit the names of the above Categories or add your own categories.  

• Modified:  shows the last time this form was modified. 
• Due:  Total amount due for service. 
• Payment :  Record any payments here.  
• Balance:  This will show any remaining balance due.  

Use the Prev and Next 
buttons to scroll through 
multiple forms for this 
patient.  
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 Printing:    
 File-Mate 1500 is capable of printing your document in two formats:  

− Preprinted red 1500 form, or  
− Plain paper in either Black or Red ink.   

 
To access the Print dialog: 

− Use the File Drop Down Menu and select the Print menu item. 
− Click on the Print Button near the top of the screen 
− Access the Print Dialog anywhere in the program by using the Quick Key  (CTRL-P) 

To Print to PRE-PRINTED 
1500 FORM: 
 
• Click on the 1500 Data Button 
• Check your print range 
• Preview if needed 
• Or click OK to print. 
 
Notes: 
  
If you are having alignment issues 
with your printer, use the Left, Right, 
Up and Down arrows to  adjust align-
ment to your form.  
 
Use this setting with plain paper and 
then hold the printout to an actual 
form to see if adjustment worked to 
save using many pre-printed forms 
during the adjustment process.  

To Print to PLAIN PAPER: 
 
• Click on the 1500 Form 
• Check your print range 
• Choose ink color under Options 

as well as other settings. 
• Preview if needed 
• Or click OK to print. 
 
 
Invoices and Reports will be 
addressed in a separate section.  
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 Here is an example of the 
preview for the Plain paper 
form. Use the tool bar at the 
top of the preview panel to 
Print, Close or Edit the  
Form . 
If you make changes in this 
view, the information will be 
transferred back to the file as 
well.  
 
If you are printing multiple 
forms (you had clicked on 
selected forms or a date 
range), you can preview the 
forms by using the arrow but-
tons to scroll through them 
before printing.  
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Backing Up Data  
 To Make a Back up of your Data go to: 
 
•  FILE  drop down menu 
•  Select EXPORT 
•  Click the BACKUP FILE  radio button 
•  Click Ok  
•  The default location to save your back up file will come up automatically 
  C: FileMate/FM4/Archive 
   
•  Accept the default location and click SAVE. 
 
Note:  You may choose a location of your choice by re-directing the browser to the location 
 you wish the backup file to be saved.  

ARCHIVED 
DATA: 

 
File-Mate 1500 v4 has a 

feature that automatically creates 
an  archive of your files for the 
last 5 times that File-Mate was 
used.    
 
If anything ever happens to your 
computer you will always have 
the last day’s data automatically 
saved.   
 
To learn more about recovering 
this data, see the IMPORT 
DATA section.  
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 For Purchasers of File-Mate 1500  Electronic Version Software 

If you own the File-Mate 1500 Electronic Version of the software, you have the added ability to produce 
NSF data files for uploading to an online Clearing House that you have established a relationship with.  
 
To Produce the NSF Data File: 
 
From the Form list on the Home page,  
• Select the form(s) you wish to export by clicking the open box on the same line(s) of the forms that 

you selecting.   
• Once all form(s) have been selected,  Click on FILE, EXPORT 
• A Export Dialogue box will appear. 
 

 
• Select Payment File  to create the Print Image Date File needed to transmit data to the   
 Clearing House of your choice for electronic processing.  
 
 File-Mate 1500 creates a file that is often referred to as a “Print Image” file and is the most 
 common file format accepted by most vendors.  
 
• Click OK.   A file will then be created that you can now send to your clearing house. 

Export Data  

DATA FILE OPTION   
   
This option is primarily for users of previous versions (versions 1.0-3.0) to accommodate the creation of 
a “Legacy” file format.   We expect this to be replaced with a more robust option in future releases of 
File-Mate 1500.  
 
If you rely on this feature, contact us at  support@formmagic.com to let us know so we can                 
accommodate your needs in the future.  

Remember: Payment 
File is only available 

for Electronic Version.  
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 Import Data from Back-up 

Import Data from a Back-up 
 
• FILE Menu 
• Select IMPORT 
• Choose BACKUP FILE 
• Click the BROWSE button 

You will then receive a 
warning message.  
Click YES to proceed.  

The default location for where 
you may have saved your back 
up file is now presented.  
 
• SELECT the Backup File  
• Click OPEN  
 
Note:  You may need to navi-
gate to the location you saved 
your back up file if you did not 
use the default location.  

You will receive a Import     
Summary showing the number of 
records that were imported.  
 
Click OK to finish the export.  
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 Import Data from Archive  

You will then receive a 
warning message.  
 Click YES to proceed.  
 
This revert your data to the 
file data from the date you 
choose. 

Import Data from an Archive 
 
• FILE Menu 
• Select IMPORT 
• Choose BACKUP FILE 
• Select the ARCHIVE File Tab 
• Click the IMPORT button next 

to the date you want to bring in.  

IMPORTING  DATA 
FILE OPTION: 

 
You can import: 
 
Data - Patient Data 
CPT Codes 
ICD Codes  
 
• FILE 
• IMPORT 
• DATA FILE 
• Use drop down menu to    

select type of Data 
• BROWSE 
• LOCATE file and click OK 



Page 18 

 Invoices  

Invoices  are found under the FILE drop down Menu.  

• FILE 
• PRINT 
• Select INVOICE 
• Choose your PRINT RANGE 
• Enter Any Terms or Footer Notes 
• Click PREVIEW Invoices if desired 
• Click OK to print.  

TIP: 
If you selected multiple forms, 
you can scroll through them in 
the PREVIEW mode by using 
these buttons.  
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 Reports 

Reports  are found under the FILE drop down Menu.  

• FILE 
• PRINT 
• Select REPORTS 
• Choose your PRINT RANGE 
• Select Report Type under OPTIONS 
• Click PREVIEW  if desired 
• Click OK to print.  

TIP: 
If you selected multiple forms, 
you can scroll through them in 
the PREVIEW mode by using 
these buttons.  
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 Moving File-Mate 1500 to a New Computer: 
Before moving your software to another computer, if possible, back up your data.  
 
To Make a Back up of your Data go to: 
 
•  FILE  drop down menu 
•  Select BACKUP FILE  
•  Click Ok  
•  The default location to save your back up file will come up automatically 
  C: FileMate/FM4/Archive 
 You may want to save the backup directly onto a flash drive so you can move it to 
 the new computer.  If so, select the appropriate drive that your flash drive is in.  
•  Click SAVE. 
 
Note:  You may choose a location of your choice by re-directing the browser to the location 
 you wish the backup file to be saved.  
 
Once the Backup is complete: 
 
Use your current installer to install the program on the new computer to ensure you have your 
original  version.  If you no longer have your installer, go to our website:   
http://www.formmagic.com and look in the updates section for installers.   
You can locate your current version from the Help Menu, About File-mate 1500. 
  
 Note:  If you are not on the current 4.0 version, you may need a different installer if 

 you are not interested in upgrading to the current version.  Contact us at             
 888-746-0440 or support@formmagic.com for additional help.  

 
Once you have installed the software on the new computer, import in the 
files by: 
 
• Open the File-Mate program  
• FILE Menu 
• Select IMPORT 
• Choose BACKUP FILE  
• Click the BROWSE button to find your flash drive.  
• You will then receive a warning message.   
• Click YES to proceed.  
• SELECT the Backup File  
• Click OPEN  
• You will receive a Import Summary showing the number of records that were 

imported.  
• Click OK to finish the export.  


